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Quick Start
In a hurry? No time to read everything? We understand. Read this section, it tells you how to use your
activation key or install your license.

The Foundry Licensing Tools’ default settings do not support RLM licensing on virtual machines (VMs).
If you have any questions regarding licensing on VMs, please visit support.foundry.com for
assistance.
Alternatively, if you want to know more about licensing, see Licensing on a Single Machine or
Licensing over a Network.

About Licenses
To license one of our products, you need one of the following:
• A subscription license - allows you to activate a single license or entitlement on any authorized
device up to the entitlement's maximum number of activations. See the products' documentation
on www.foundry.com for more information.
• Free trial license. This enables one of our products to work on one particular machine for 15 days.
See Free Trial Licenses.
• An activation key - An activation key can be used as an automated path to a node locked license,
allowing you to use the Foundry products on a single machine. They look something like this:
mari-0101-77d3-99bd-a977-93e9-8035
See Activation Keys.
• A node locked license - This enables one of our products to work on one particular machine. It is
locked to a unique number on that machine.
• A floating license - This enables one of our products to work on any networked client machine. The
floating license should be put on the server and is locked to a unique number on that server.
See Node Locked and Floating Licenses.
If you want to know what a license looks like, have a look at Appendix A: License Syntax for a
description of the file syntax.
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Free Trial Licenses
If you simply want to obtain a free trial license for 15 days, you can:
• launch your product and, if a Licensing dialog appears, click the Try... button, or

• if your product doesn’t have a Licensing dialog, you may be able to obtain a trial license from our
website at www.foundry.com. On the product page, click Free 15 day trial and follow the
instructions.
You can only install a trial license once for each product on a single machine.

Activation Keys
This section tells you how to use an activation key with your product.

Purchasing an Activation Key
If you've been supplied with something that looks similar to this:
mari-0101-3733-eeda-8376-df83-7235
you have an activation key and you can activate your product.
If your product uses activation key-based licensing but you don’t yet have an activation key, you can
purchase one by:
• using the Buy... button on the Licensing dialog when you first launch your product,
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• going to our web site at www.foundry.com,
• e-mailing us at sales@foundry.com,
• phoning our London office at +44 20 7479 4350 or our Los Angeles office at +1 (310) 399 4555.
Once you have an activation key, proceed to How to Use Your Activation Key.

How to Use Your Activation Key
If you are using a product that has a Licensing dialog (such as Mari or Hiero) and currently have no
license, or are running a temporary license, your product prompts you at start-up to enter your
activation key into the Licensing dialog. This step is skipped if:
• you’ve already activated a permanent license, or
• you’re trying to activate a product that doesn’t have a Licensing dialog (for example, a set of plugins). If this is the case, go to www.foundry.com/user/login?destination=/licensing/activate-product,
enter your activation key into the field provided, and follow the instructions on screen.
If you’re trying to activate a product using the Licensing dialog, do the following:
1. Launch your product.
The Licensing dialog displays.
2. Click Install License.
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3. Click Activation Key / License Text.
4. Enter your activation key and click Install.
Your product connects to our activation server, retrieves the correct license key for your system,
and installs it.
Your product launches when the download and installation are complete.

Node Locked and Floating Licenses
This section tells you how to obtain and install node locked and floating licenses for your product.
NOTE: For a complete explanation of licenses, license syntax, alternative license directories,
useful server commands, and much more, please read Licensing on a Single Machine or
Licensing over a Network.
To troubleshoot licenses, refer to Troubleshooting Licenses.
The instructions for installing node locked and floating licenses depend on your operating system, so
before you do anything else choose one of the following:
• To install a license on Windows, see Windows.
• To install a license on Mac OS X, see Mac OS X.
• To install a license on Linux, see Linux.

Windows
This section tells you how to get your license working on Windows.
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Purchasing a License
You can purchase license keys by:
• going to our web site at www.foundry.com,
• e-mailing us at sales@foundry.com,
• phoning our London office at +44 20 7479 4350 or our Los Angeles office at +1 (310) 399 4555.
To generate a license key, we need to know your System ID. The System ID returns a unique number
for your computer. We lock our license keys to the System ID.
For floating licenses, we need to know the System ID of the machine that serves the licenses across
the network.
To display your System ID, download the Foundry License Utility (FLU) from
www.thefoundry.co.uk/support/licensing/ and run it. The System ID is displayed at the bottom of the
window, as highlighted.

Installing a License Key
Once a license has been generated for you, we e-mail you a zip file containing the license key and
instructions on how to obtain the correct version of the Foundry License Utility (FLU). To check and
install the license key, install the Windows FLU and drag the license file onto the FLU application.
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If you installed a node locked license key, you’re done.
When you install a floating license key, the license server address is displayed on screen:
<number>@<license server name>
You should make a note of the address, as you’ll need it to activate the client machines. Then,
proceed to Installing the Foundry Licensing Tools (FLT) on the License Server.

Installing the Foundry Licensing Tools (FLT) on the License Server
Having installed a floating license, you need to install some additional software (FLT) to manage the
licenses on your network. Then you need to tell the client machines where to find the licenses.
1. Download FLT_7.3v1_win-x86-release-64.exe from our web site
(www.thefoundry.co.uk/support/licensing/) and install it on the Windows computer that you want
to serve the licenses across the network.
The license server starts automatically after installation (and whenever you restart the machine).
2. To check the server status, click Start > All Programs > The Foundry > FLT 7.3v1 > Foundry
License Utility, view the RLM Server tab, and click Refresh Log.
3. If the license server fails to start, navigate to Control Panel > Systems and Security >
Administrative Tools > Services. Then, select the appropriate service: Foundry License Server
Click Start and check the server status again.
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NOTE: If you have a firewall on your license server, this blocks all requests for licenses from
your clients. So all that good work you’ve done in setting up your Foundry License Server will
be for nothing unless you fix this. See Firewalls.
4. Proceed to Telling the Client Machines Where to Find the Licenses.

Telling the Client Machines Where to Find the Licenses
To point your product at the license server, do one of the following:
• If your product displays a Licensing dialog when you launch it, click Install License and then Use
Server. Type <number>@<server name> (for example, 4101@red) and click Install. Your client
retrieves a license from the License Server and launches.
• Download the Foundry License Utility (FLU) from our website
(www.thefoundry.co.uk/support/licensing/) and launch it. Make sure you are viewing the License
Install tab and copy and paste in an RLM server line:
HOST <server name> any <port>
For example: HOST red any 4101
This creates and installs a client license.
Repeat this process for each machine you wish to have access to licenses on the server.

Mac OS X
This section tells you how to get your license working on Mac OS X.

Purchasing a License
You can purchase license keys by:
• going to our web site at www.foundry.com,
• e-mailing us at sales@foundry.com,
• phoning our London office at +44 20 7479 4350 or our Los Angeles office at +1 (310) 399 4555.
To generate a license key, we need to know your System ID. The System ID returns a unique number
for your computer. We lock our license keys to the System ID.
For floating licenses, we need to know the System ID of the machine that serves the licenses across
the network.
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To display your System ID, download the Foundry License Utility (FLU) from
www.thefoundry.co.uk/support/licensing/ and run it. The System ID is displayed at the bottom of the
window, as highlighted.

Installing a License Key
Once a license has been generated for you, we e-mail you a zip file containing the license key and
instructions on how to obtain the correct version of the Foundry License Utility (FLU). To check and
install the license key, install the Mac OS X FLU and drag the license file onto the FLU application.

If you installed a node locked license key, you’re done.
When you install a floating license key, the license server address is displayed on screen:
<number>@<license server name>
You should make a note of the address, as you’ll need it to activate the client machines. Then,
proceed to Installing the Foundry Licensing Tools (FLT) on the License Server.
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Installing the Foundry Licensing Tools (FLT) on the License Server
Having installed a floating license, you need to install some additional software (FLT) to manage the
licenses on your network. Then you need to tell the client machines where to find the licenses.
1. Download FLT_7.3v1_mac-x86-release-64.dmg from our web site
(www.thefoundry.co.uk/support/licensing/) and install it on the Mac that you want to serve the
licenses across the network.
The license server starts automatically after installation (and whenever you restart the machine).
2. To check the server status, navigate to /Applications/TheFoundry/LicensingTools7.3, doubleclick on Foundry License Utility, view the RLM Server tab, and click Refresh Log.
3. Proceed to Telling the Client Machines Where to Find the Licenses.

Telling the Client Machines Where to Find the Licenses
To point your product at the license server, do one of the following:
• If your product displays a Licensing dialog when you launch it, click Install License and then Use
Server. Type <number>@<server name> (for example, 4101@red) and click Install. Your client
retrieves a license from the License Server and launches.
• Download the Foundry License Utility (FLU) from our website
(www.thefoundry.co.uk/support/licensing/) and launch it. Make sure you are viewing the License
Install tab and copy and paste in an RLM server line:
HOST <server name> any <port>
For example: HOST red any 4101
This creates and installs a client license.
Repeat this process for each machine you wish to have access to licenses on the server.

Linux
This section tells you how to get your license working on Linux.

Purchasing a License
You can purchase license keys by:
• going to our web site at www.foundry.com,
• e-mailing us at sales@foundry.com,
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• phoning our London office at +44 20 7479 4350 or our Los Angeles office at +1 (310) 399 4555.
To generate a license key, we need to know your System ID. The System ID returns a unique number
for your computer. We lock our license keys to the System ID.
For floating licenses, we need to know the System ID of the machine that serves the licenses across
the network.
To display your System ID, download the Foundry License Utility (FLU) from
www.thefoundry.co.uk/support/licensing/ and run it from the command line:
<download location>/FoundryLicenseUtility -i
NOTE: The <download location> refers to the location where you saved the Foundry
Licensing Utility.

Installing a License Key
1. Once a license has been generated for you, we e-mail you a .tgz file containing the license key and
instructions on how to obtain the correct version of the Foundry License Utility (FLU). Gunzip or
untar the file and save the FLU and your license key to a folder of your choice.
2. Navigate to the location of the FLU_7.3v1_linux-x86-release-64.tgz file.
3. Type the following commands to extract and install the FLU. Note that you need to replace [my
license] with the location of your license key.
tar xvzf FLU_7.3v1_linux-x86-release-64.tgz
cd FLU_7.3v1_linux-x86-release-64
./FoundryLicenseUtility -l [my license]
For example, if you saved your license key to /tmp/foundry.lic, the last line should be:
./FoundryLicenseUtility -l /tmp/foundry.lic
This checks the license key and copies it to the correct directory.
4. If you installed a node locked license key, you’re done.
If you installed a floating license key, the license server address is displayed on screen:
<number>@<license server name>
You should make a note of the address, as you’ll need it to activate the client machines. Then,
proceed to Installing the Foundry Licensing Tools (FLT) on the License Server.

Installing the Foundry Licensing Tools (FLT) on the License Server
Having installed a floating license, you need to install some additional software (FLT) to manage the
licenses on your network. Then you need to tell the client machines where to find the licenses.

17

Node Locked and Floating Licenses | Telling the Client Machines Where to Find the Licenses

1. Download FLT_7.3v1_linux-x86-release-64.tgz from our web site
(www.thefoundry.co.uk/support/licensing/) on the Linux machine that you want to serve these
licenses across the network and save it to /tmp.
2. Open a shell and, using root or admin permissions, type these commands to extract and install
the Foundry Licensing Tools 7.3v1.
cd /tmp
tar xvzf FLT_7.3v1_linux-x86-release-64.tgz
cd FLT_7.3v1_linux-x86-release-64
./install.sh
The license server starts automatically after installation (and whenever you restart the machine).
3. To check the server status, navigate to /usr/local/foundry/LicensingTools7.3 and enter:
./FoundryLicenseUtility -s status
4. Proceed to Telling the Client Machines Where to Find the Licenses.

Telling the Client Machines Where to Find the Licenses
To point your product at the license server, do one of the following:
• If your product displays a Licensing dialog when you launch it, click Install License and then Use
Server. Type <number>@<server name> (for example, 4101@red) and click Install. Your client
retrieves a license from the License Server and launches.
• Download the Foundry License Utility (FLU) from our website
(www.thefoundry.co.uk/support/licensing/). Gunzip or untar the file and save the FLU to a folder of
your choice. Then, launch a shell and navigate to the location of the FLU_7.3v1_linux-x86-release64.tgz file. Type the following commands:
tar xvzf FLU_7.3v1_linux-x86-release-64.tgz
cd FLU_7.3v1_linux-x86-release-64
./FoundryLicenseUtility -c <port>@<server name>
For example, the last line might be:
./FoundryLicenseUtility -c 4101@red
This creates and installs a client license.
Repeat this process for each machine you wish to have access to licenses on the server.
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Licensing on a Single Machine
This section tells you how to license your product on a single machine. If you want to license one of
our products over a network instead, please read Licensing over a Network.

NOTE: The Foundry Licensing Tools’ default settings do not support RLM licensing on virtual
machines (VMs). If you have any questions regarding licensing on VMs, please visit
support.foundry.com for assistance.
NOTE: This guide should cover all the information you need to use RLM licenses for Foundry
products. However, it is not meant to be an exhaustive exploration of all the features
available with RLM licensing.
For that, you should see the RLM Licensing End User Guide included in the Foundry
Licensing Tools download or go to www.reprisesoftware.com. Please be aware that advanced
RLM features not discussed in this guide are not supported with RLM licenses from Foundry.

About Licenses
To license one of our products on a single machine, you need either:
• An activation key. An activation key can be used as an automated path to a node locked license. It
is a string of characters that represents your entitlement to a product license. You can use activation
keys over the internet to create automatically installed full license keys, on a machine of your
choice, using our activation server.
Activation keys are a flexible approach to selling licenses, requiring no System ID at the point of
purchase, though activation can only occur once per activation key.
They look something like this:
mari-0101-77d3-99bd-a977-93e9-8035
For information on how to license one of our products using an activation key, see Activation Keys.
• A node locked license. This is sometimes called an uncounted license. It enables one of our
products to work on one particular machine. It is locked to a unique number on that machine. This
license key does not work on a different machine and if you need it to, you’ll have to transfer your
license. Like activation keys, node locked licenses do not require additional licensing software to be
installed.
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Node locked licenses look like this:
LICENSE foundry mari_i 2011.1231 permanent uncounted share=h start=3-oct2011 issued=3-oct-2011 _ck=fa062a5e5a
sig="60P0451P8JTKNGTUC2TR605Y300BQ63CKYJNYTG22GXS0AVA0DSFGSUJ8P8HJ1C5MX86UNS
54M"
For further information about the structure of the license key, see Node Locked License Syntax.
For information on how to license one of our products using a node locked license, see Node
Locked Licenses.
TIP: We also provide free 15-day trial licenses. See Free Trial Licenses.

Activation Keys
This section tells you how to use an activation key with your product.

Purchasing an Activation Key
If you've been supplied with something that looks similar to this:
mari-0101-3733-eeda-8376-df83-7235
you have an activation key and you can activate your product.
If your product uses activation key-based licensing but you don’t yet have an activation key, you can
purchase one by:
• using the Buy... button on the Licensing dialog when you first launch your product,

• going to our web site at www.foundry.com,
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• e-mailing us at sales@foundry.com,
• phoning our London office at +44 20 7479 4350 or our Los Angeles office at +1 (310) 399 4555.
Once you have an activation key, proceed to How to Use Your Activation Key.

How to Use Your Activation Key
If you currently have no license, or are running a temporary license, your product prompts you at
launch to enter your activation key into a Licensing dialog. This step is skipped if:
• you’ve already activated a permanent license, or
• you’re trying to activate a product that doesn’t have a Licensing dialog (for example, a set of plugins). If this is the case, go to www.foundry.com/user/login?destination=/licensing/activate-product,
enter your activation key into the field provided, and follow the instructions on screen.
If you’re trying to activate a product that does have a Licensing dialog, such as Nuke, do the following:
1. Launch your product.
The Licensing dialog displays.
2. Click Install License to display the available license installation options.

3. Click Activation Key / License Text and then either:
• Enter the Activation Key string in place of Insert Activation Key Here. A license key typically
looks something like this:
nuke-0101-77d3-99bd-a977-93e9-8035
OR
• Copy the license text and paste it over the Copy/Paste license text here string. License text
typically looks something like this:
INCREMENT nuke_i foundry 2013.0929 29-sep-2014 uncounted \
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HOSTID=000a957bfde5 ISSUED=29-sep-2012 \
SIGN="00DA 99A9 E744 217E 8AD3 E7AF E289 C0C6 \
6B23 2891 AC01 0F50 E64D 8847 8B22 3A40 2BE9 \
A268 B7C2 4BC0 36AF"
4. Click Install.
Your product connects to our activation server, retrieves the correct license key for your system,
and installs it.
Your product launches when the download and installation are complete.
NOTE: If you access the internet through a proxy server, you may be prompted to enter the
server name, port number, username, and password before the product can obtain a
license.

Node Locked Licenses
This section tells you how to obtain and install node locked licenses for your product.

Purchasing a Node Locked License
You can purchase node locked license keys by:
• going to our web site at www.foundry.com,
• e-mailing us at sales@foundry.com,
• phoning our London office at +44 20 7479 4350 or our Los Angeles office at +1 (310) 399 4555.
To generate a license key, we need to know your System ID. The System ID (sometimes called Host ID,
lmhostid, or rlmhostid) returns a unique number for your computer. We lock our license keys to the
System ID. Just so you know what a System ID number looks like, here’s an example:
000ea641d7a1
There are a number of ways to display your System ID, depending on your operating system.

On Windows
• Download the Foundry License Utility (FLU) from our website
(www.thefoundry.co.uk/support/licensing/) and run it.
The System ID is displayed at the bottom of the window, as highlighted.
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• Alternatively, you can run the following from a command prompt:
<download location>/FLU_7.3v1_win-x86-release-64.exe -i
NOTE: The <download location> refers to the location where you saved the Foundry
Licensing Utility.
NOTE: If you use the FLU from a command prompt and don’t pass it any arguments (such as
-i in the above example), it launches in GUI mode.

On Mac
• Download the Foundry License Utility (FLU) from our website
(www.thefoundry.co.uk/support/licensing/) and run it.
The System ID is displayed at the bottom of the window, as highlighted.
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• Alternatively, you can run the following from the Terminal:
<download
location>/FoundryLicenseUtility.app/Contents/MacOS/FoundryLicenseUtility -i
NOTE: The <download location> refers to the location where you saved the Foundry
Licensing Utility.

On Linux
Download the Foundry License Utility (FLU) from our website
(www.thefoundry.co.uk/support/licensing/) and run it from the command line:
<download location>/FoundryLicenseUtility -i
NOTE: The <download location> refers to the location where you saved the Foundry
Licensing Utility.

Installing a Node Locked License
Once you have a node locked license, you can install it using two methods:
• The automated method (recommended). The easiest way to install a node locked license is to use
Foundry License Utility (FLU).
On Windows and Mac OS X, the FLU can be used both in graphical user interface (GUI) mode and
from the command line.
On Linux, the FLU is a command line tool only.
For more information, see one of the following:
• The Automated Method on Windows
• The Automated Method on Mac OS X

24

Node Locked Licenses | The Automated Method on Windows

• The Automated Method on Linux
• The manual method. We do not recommend this, but you can install a node locked license key by
hand. You just need the license key in a text file and your product. No other software is required.
For more information, see The Manual Method: Windows, Mac OS X, and Linux.

The Automated Method on Windows
Once a license has been generated for you, we e-mail you a zip file containing the license key and
instructions on how to obtain the correct version of the Foundry License Utility (FLU). To check and
install the license key, install the Windows version of the FLU and do one of the following:
• Drag the license file onto the FLU application;

• Or cut and paste the license key text directly into the License Install tab in the FLU application;
• Or if you double-click on the FLU application, it installs any file with a .lic file extension that it finds
in the same directory as the application.
NOTE: If there is an error with any part of the license installation, this is reported in the FLU.
You should also see a Generate Report button, which you can click to write the errors out
to a file and then visit support.foundry.com for assistance.
If you are installing several licenses at the same time and only some of them fail validation,
you can also click Continue to complete the installation of the valid licenses.
The above methods are the easiest way to install a license. However, if you prefer, you can also install
a license from a command prompt. To do so:
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1. Save the FLU and your license key to a folder of your choice. Note that the license file can be the
original .lic file or the license in a plain text file (as long as the file has a .lic extension).
2. Click Start, type cmd and press Return.
This launches a command prompt.
3. Navigate to the location of the FLU_7.3v1_win-x86-release-64.exe file.
4. Type the following command to install the FLU and the license. Note that you need to replace [my
license] with the location of your license key.
FLU_7.3v1_win-x86-release-64.exe -l[my license]
For example, if you saved your license key to D:\Temp\foundry.lic, the command should be:
FLU_7.3v1_win-x86-release-64.exe -l D:\Temp\foundry.lic
This checks the license key and copies it to the correct directory. You’re done.
NOTE: If you use the FLU from a command prompt and don’t pass it any arguments (such as
-l in the above example), it launches in GUI mode.

The Automated Method on Mac OS X
Once a license has been generated for you, we e-mail you a zip file containing the license key and
instructions on how to obtain the correct version of the Foundry License Utility (FLU). To check and
install the license key, install the Mac OS X version of the FLU and do one of the following:
• Drag the license file onto the FLU application;

• Or cut and paste the license key text directly into the License Install tab in the FLU application;
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• Or if you double click on the FLU application, it installs any file with a .lic file extension that it finds
in the same directory as the application.
NOTE: If there is an error with any part of the license installation, this is reported in the FLU.
You should also see a Generate Report button, which you can click to write the errors out
to a file and then visit support.foundry.com for assistance.
If you are installing several licenses at the same time and only some of them fail validation,
you can also click Continue to complete the installation of the valid licenses.
The above methods are the easiest way to install a license. However, if you prefer, you can also install
a license from the command line. To do so:
1. Save the FLU and your license key to a folder of your choice. Note that the license file can be the
original .lic file or the license in a plain text file.
2. Launch Terminal and navigate to the location of the FLU_7.3v1_mac-x86-release-64.zip file.
3. Type the following commands to extract and install the FLU and the license. Note that you need to
replace [my license] with the location of your license key.
unzip FLU_7.3v1_mac-x86-release-64.zip
cd FoundryLicenseUtility.app/Contents/MacOS
./FoundryLicenseUtility -l [my license]
For example, if you saved your license key to /tmp/foundry.lic, the last line should be:
./FoundryLicenseUtility -l /tmp/foundry.lic
This checks the license key and copies it to the correct directory. You’re done.

The Automated Method on Linux
Once a license has been generated for you, we e-mail you a .tgz file containing the license key and
instructions on how to obtain the correct version of the Foundry License Utility (FLU).
1. Gunzip or untar the file and save the FLU and your license key to a folder of your choice. Note
that the license file can be the original .lic file or the license in a plain text file.
2. Launch a command line and navigate to the location of the FLU_7.3v1_linux-x86-release-64.tgz
file.
3. Type the following commands to extract the FLU and install the license. Note that you need to
replace [my license] with the location of your license key.
tar xvzf FLU_7.3v1_linux-x86-release-64.tgz
cd FLU_7.3v1_linux-x86-release-64
./FoundryLicenseUtility -l [my license]
For example, if you saved your license key to /tmp/foundry.lic, the last line should be:
./FoundryLicenseUtility -l /tmp/foundry.lic
This checks the license key and copies it to the correct directory. You’re done.
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NOTE: If there is an error with any part of the license installation, this is reported on the
command line. You should also see a Generate Report button, which you can click to write
the errors out to a file and then visit support.foundry.com for assistance.
If you are installing several licenses at the same time and only some of them fail validation,
you can continue to complete the installation of the valid licenses.

The Manual Method: Windows, Mac OS X, and Linux
If you wish, you can install a node locked license key by hand. The license key goes in any plain text
file with a .lic file extension in a specific directory. The name of the file can be anything, but we
recommend the following:
foundry.lic
Make sure you don’t save the key in a rich text (.rtf) file as it won’t work. You should also avoid using
Word or other word processing programs to create license files, as these add invisible control
characters that trip up the licensing and make it hard for us to diagnose the fault.
The recommended location for the license file varies depending on the operating system you are
using, and is as follows:
NOTE: There are other directories that can be searched for license files. See Moving the
License Keys and Log Files.
On Windows
C:\ProgramData\The Foundry\RLM\
NOTE: The ProgramData folder may be hidden. You can make it visible using the Folder
Options in the Control Panel. See Windows Hidden Files.
On Mac OS X:
/Library/Application Support/TheFoundry/RLM/
On Linux:
/usr/local/foundry/RLM/
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License Administration
The following section contains details on license management and administration, including license
behavior, file location, and updating licenses.

Where are the License Keys and Log Files?
You can move the license keys and log files anywhere, but by default they are installed to the
following directories. We’ll refer to these locations as the <data path>.
<data path> on Windows:
C:\ProgramData\The Foundry\RLM\
NOTE: The ProgramData folder may be hidden. You can make it visible using the Folder
Options in the Control Panel. See Windows Hidden Files.
<data path> on Mac OS X:
/Library/Application Support/TheFoundry/RLM/
<data path> on Linux:
/usr/local/foundry/RLM/

Moving the License Keys and Log Files
Moving the License File
If you move your node locked license key, you have to set an environment variable to point to the
new location.
1. Move your node locked license key to a new location, for example:
/home/licenses/mylicense.lic
2. Now set the appropriate environment variable to point to the new location, foundry_LICENSE.
For more information on setting environment variables, see Setting Environment Variables.

Moving the Log File
By default, problems with licenses are written to:
<data path>/license.log
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You can change the location by setting the appropriate environment variable to the directory of your
choice, for example:
/home/fred/problems.log
The environment variable is foundry_LICENSE_LOG.
For more information on setting environment variables, see Setting Environment Variables.
TIP: A good command to use on very large log files to display the last 30 entries is:
tail -n 30 foundry.log
Note, however, that if you want to send the log file to the Support team, it should be the
complete log file created using the diagnostics tool in the Foundry License Utility (FLU). See
Contacting Support.

Appending to an Existing License
You can add a new license to an existing key using two methods:
• Drop the license file onto the Foundry License Utility (FLU). This is the recommended method.
• Use the command line. This is not recommended for most users. However, you can add a new
license key by editing the foundry.lic text file. Simply copy and paste the license to the end of your
existing license file.
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Licensing over a Network
This section tells you how to license your product over a network. If you want to license one of our
products on a single machine instead, please read Licensing on a Single Machine.

NOTE: The Foundry Licensing Tools’ default settings do not support RLM licensing on virtual
machines (VMs). If you have any questions regarding licensing on VMs, please visit
support.foundry.com for more information.
NOTE: This guide should cover all the information you need to use RLM licenses for Foundry
products. However, it is not meant to be an exhaustive exploration of all the features
available with RLM licensing.
For that, you should see the RLM Licensing End User Guide included in the Foundry
Licensing Tools download or go to www.reprisesoftware.com.
Please be aware that advanced RLM features not discussed in this guide are not supported
with RLM licenses from Foundry.
NOTE: Throughout this guide, we refer to machines that serve licenses as servers and
machines that ask for licenses as clients.

About Floating Licenses
A floating license running on a server enables one of our products to work on any networked client
machine. Floating licenses are sometimes called counted licenses.
The floating license should be put on the server and is locked to a unique number on that server (see
Displaying Your System ID). Floating licenses on a server require additional software to be installed.
This software manages those licenses on the server, giving licenses out to client stations that want
them. The software you need to manage these licenses is called the Foundry Licensing Tools (FLT),
which can be freely downloaded from our web site.
Floating licenses often declare a port number. This is required if you have an internet firewall on your
license server so that you can permit license communication while blocking others. See Firewalls.
A floating license looks like this:
HOST <server_name> d49a20b9be26 4101
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ISV foundry
LICENSE foundry mari_i 2012.1231 permanent 20 share=h start=4 oct-2010
issued=4-oct-2010 _ck=fa072c6a5a
sig="60P0453JHKQBGTB1HH7E3HNW843UJ627TSF4CXR22H7KNMYHG1B99WBSNHS1UE7FCN2W3AY8
KV"
For further information about the structure of the license key, see Floating License Syntax.
For information on how to license one of our products using a floating license, see Purchasing a
Floating License and Installing a Floating License.

Purchasing a Floating License
You can purchase a floating license by:
• going to our web site at www.foundry.com,
• e-mailing us at sales@foundry.com,
• phoning our London office at +44 20 7479 4350 or our Los Angeles office at +1 (310) 399 4555.
To generate a license key, we need to know the System ID of the machine that acts as the server (not
one of the clients). The System ID (sometimes called Host ID, lmhostid, or rlmhostid) returns a unique
number for that computer. Just so you know what a System ID number looks like, here’s an example:
000ea641d7a1.
To display your server machine’s System ID, see Displaying Your System ID.
Once you have provided us with your server machine’s System ID number and a license key has been
generated for you, you receive the license key in an e-mail or internet download. The license key is
contained in a text file called foundry.lic. For information on what to do with the foundry.lic file, see
Installing a Floating License.

Displaying Your System ID
There are a number of ways to display your server machine’s System ID, depending on your operating
system.

On Windows
• Download the Foundry License Utility (FLU) from our website
(www.thefoundry.co.uk/support/licensing/) and run it on the machine that acts as the server.
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The System ID is displayed at the bottom of the window, as highlighted.

• Alternatively, you can run the following from a command prompt:
<download location>/FLU_7.3v1_win-x86-release-64.exe -i
NOTE: The <download location> refers to the location where you saved the Foundry
Licensing Utility.
NOTE: If you use the FLU from a command line and don’t pass it any arguments (such as -i
in the above example), it launches in GUI mode.

On Mac
• Download the Foundry License Utility (FLU) from our website
(www.thefoundry.co.uk/support/licensing/) and run it on the machine that acts as the server.
The System ID is displayed at the bottom of the window, as highlighted.
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• Alternatively, you can run the following from the command line:
<download
location>/FoundryLicenseUtility.app/Contents/MacOS/FoundryLicenseUtility -i
NOTE: The <download location> refers to the location where you saved the Foundry
Licensing Utility.

On Linux
On the machine that acts as the server, download the Foundry License Utility (FLU) from our website
(www.thefoundry.co.uk/support/licensing/) and run it from the command line:
<download location>/FoundryLicenseUtility -i
NOTE: The <download location> refers to the location where you saved the Foundry
Licensing Utility.

Installing a Floating License
The Foundry Licensing Tools are supplied for Windows, Mac OS X, and Linux. To manage floating
licenses across a network, you have to install the Foundry Licensing Tools on a license server together
with your floating license key(s). Then you have to tell your client machines where to look for their
license. How to do all this depends on your operating system:
• If you’re on Windows, see Windows.
• If you’re on Mac OS X, see Mac OS X.
• If you’re on Linux, see Linux.
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Windows
This section tells you how to get your floating license working on Windows.

Installing a Floating License on the License Server
1. Once a license has been generated for you, we e-mail you a zip file containing the license key and
instructions on how to obtain the correct version of the Foundry License Utility (FLU). To check
and install the license key, install the Windows version of the FLU and do one of the following:
• Drag the license file onto the FLU application, or

• Cut and paste the license key text directly into the License Install tab in the FLU application, or
• If you double-click on the FLU application, it installs any file with a .lic file extension that it finds
in the same directory as the application.
2. The license server address is displayed on screen:
<number>@<license server name>
You should make a note of the address as you’ll need it to activate the client machines.
3. Proceed to Installing Foundry Licensing Tools (FLT) on the License Server.
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NOTE: If there is an error with any part of the license installation, this is reported in the FLU.
You should also see a Generate Report button, which you can click to write the errors out
to a file and then visit support.foundry.com for assistance.
If you are installing several licenses at the same time and only some of them fail validation,
you can also click Continue to complete the installation of the valid licenses.
You may also get a message saying that the license is not yet valid but may be valid in the
future. This means the license has been installed successfully and will automatically become
live on the license start date. You do not need to do anything further, but if you like, you can
check that the server is up and the server log reports the same message (see Viewing the
License Server Log).

Alternative Methods of Installing the License
The above methods are the easiest way to install a license. However, if you prefer, you can also install
a license from a command prompt. To do so:
1. Save the FLU and your license key to a folder of your choice. Note that the license file can be the
original .lic file or the license in a plain text file (as long as the file has a .lic extension).
2. Click Start, type cmd and press Return.
This launches a command prompt.
3. Navigate to the location of the FLU_7.3v1_win-x86-release-64.exe file.
4. Type the following command to install the FLU and the license. Note that you need to replace [my
license] with the location of your license key.
FLU_7.3v1_win-x86-release-64.exe -l[my license]
For example, if you saved your license key to D:\Temp\foundry.lic, the command should be:
FLU_7.3v1_win-x86-release-64.exe -l D:\Temp\foundry.lic
This checks the license key and copies it to the correct directory.
5. The license server address is displayed on screen:
<number>@<license server name>
You should make a note of the address as you’ll need it to activate the client machines.
6. Proceed to Installing Foundry Licensing Tools (FLT) on the License Server.
NOTE: If you use the FLU from a command prompt and don’t pass it any arguments (such as
-l in the example), it launches in GUI mode.
Alternatively, if you wish, you can install the license key by hand, though this is not recommended for
most users. To do so:
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1. Launch a text editor and create a plain text file. Avoid using Word or other word processing
programs to create the file, as these add invisible control characters that trip up the licensing and
make it hard for us to diagnose the fault.
2. Copy the license key and paste it into the plain text file.
3. Save the file with a .lic extension (not .txt or .rtf) in the following directory: C:\ProgramData\The
Foundry\RLM\
The name of the file can be anything, but we recommend calling it foundry.lic.
NOTE: The ProgramData folder may be hidden. You can make it visible using the Folder
Options in the Control Panel. See Windows Hidden Files.
NOTE: There are other directories that can be searched for license files. See Moving the RLM
Files.
4. Create an options file and set a TIMEOUT or TIMEOUTALL period. This ensures that licenses are
returned to the server if the server and client machines lose contact with each other (due to a
network error, a crash, or some other failure). For more information, see Setting a TIMEOUT or
TIMEOUTALL Period.
5. Proceed to Installing Foundry Licensing Tools (FLT) on the License Server.

Installing Foundry Licensing Tools (FLT) on the License Server
1. Download FLT_7.3v1_win-x86-release-64.exe from our web site
(www.thefoundry.co.uk/support/licensing/) and install it on the Windows computer that you want
to serve the licenses across the network.
The license server starts automatically after installation (and whenever you restart the machine).
2. To check the server status, click Start > All Programs > The Foundry > FLT 7.3v1 > Foundry
License Utility, view the RLM Server tab, and click Refresh Log.
To check RLM server status, you can also direct a web browser to the http://<server_name>:4102
server page and click Status on the left.
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3. If the license server fails to start, navigate to Control Panel > System and Security >
Administrative Tools > Services. Then, select the appropriate service:
• Foundry License Server
Click Start and check the server status again.
NOTE: If you have a firewall on your license server, this blocks all requests for licenses from
your clients. So all that good work you’ve done in setting up your Foundry License Server will
be for nothing unless you fix this. See Firewalls.
4. Proceed to Telling the Client Machines Where to Find the Licenses.

Telling the Client Machines Where to Find the Licenses
When you installed the floating license key on your server, you were provided with a <port>@<server
name>. You need this to license clients.
There are several ways to license clients. Choose one of the following and repeat it for each machine
you wish to have access to licenses on the server:
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• If your product displays a Licensing dialog when you launch it, click Install License and then Use
Server. Type <number>@<server name> (for example, 4101@red) and click Install. Your client
retrieves a license from the License Server and launches.
• Click Start > All Programs > The Foundry > FLT 7.3v1 > Foundry License Utility to launch the FLU.
Make sure you are viewing the License Install tab and copy and paste in an RLM server line:
HOST <server name> any <port>
For example: HOST red any 4101
This creates and installs a client license.
• Launch a command prompt. Navigate to the location of the FoundryLicenseUtility.exe file, by
default:
C:\Program Files\The Foundry\LicensingTools7.3
Then, type the following command:
FoundryLicenseUtility.exe -c <port>@<server name>
For example:
FoundryLicenseUtility.exe -c 4101@red
This creates and installs a client license.
• Set an environment variable on your client as follows:
Set the foundry_LICENSE environment variable on your client to point to the license server (for
example, 4101@red). If you have more than one server, you could use:
4101@red:4101@green
If you are using a port other than 4101, replace 4101 with the port selected.
For more information on setting environment variables, see Setting Environment Variables.
• Although not recommended, you can manually create a client license.
Copy the foundry.lic file from the server to:
C:\ProgramData\The Foundry\RLM
Rename the file and call it foundry_client.lic. Edit the file so it looks like this:
HOST red 000a957bade9 4101
or if you had your own server port number set:
HOST red 000a957bade9 30001

Mac OS X
This section tells you how to get your floating license working on Mac OS X.
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Installing a Floating License on the License Server
1. Once a license has been generated for you, we e-mail you a zip file containing the license key and
instructions on how to obtain the correct version of the Foundry License Utility (FLU). To check
and install the license key, install the Mac OS X version of the FLU and do one of the following:
• Drag the license file onto the FLU application, or

• Drag the license file onto the Foundry License Utility, or
• Cut and paste the license key text directly into the License Install tab in the FLU application, or
• If you double-click on the FLU application, it installs any file with a .lic file extension that it finds
in the same directory as the application.
2. The license server address is displayed on screen:
<number>@<license server name>
You should make a note of the address as you’ll need it to activate the client machines.
3. Proceed to Installing Foundry Licensing Tools (FLT) on the License Server.
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NOTE: If there is an error with any part of the license installation, this is reported in the FLU.
You should also see a Generate Report button, which you can click to write the errors out
to a file and then visit support.foundry.com for assistance.
If you are installing several licenses at the same time and only some of them fail validation,
you can also click Continue to complete the installation of the valid licenses.
You may also get a message saying that the license is not yet valid but may be valid in the
future. This means the license has been installed successfully and will automatically become
live on the license start date. You do not need to do anything further, but if you like, you can
check that the server is up and the server log reports the same message (see Viewing the
License Server Log).

Alternative Methods of Installing the License
The above methods are the easiest ways to install a license. However, if you prefer, you can also
install a license from the command line. To do so:
1. Save the FLU and your license key to a folder of your choice. Note that the license file can be the
original .lic file or the license in a plain text file (as long as the file has a .lic extension).
2. Launch a Terminal and navigate to the location of the FLU_7.3v1_mac-x86-release-64.zip file.
3. Type the following commands to extract and install the FLU and the license. Note that you need to
replace [my license] with the location of your license key.
unzip FLU_7.3v1_mac-x86-release-64.zip
cd FoundryLicenseUtility.app/Contents/MacOS/
./FoundryLicenseUtility -l [my license]
For example, if you saved your license key to /tmp/foundry.lic, the last line should be:
./FoundryLicenseUtility -l /tmp/foundry.lic
This checks the license key and copies it to the correct directory.
4. The license server address is displayed on screen:
<number>@<license server name>
You should make a note of the address as you’ll need it to activate the client machines.
5. Proceed to Installing Foundry Licensing Tools (FLT) on the License Server.
Alternatively, if you wish, you can install the license key by hand, though this is not recommended for
most users. To do so:
1. Launch a text editor and create a plain text file. Avoid using Word or other word processing
programs to create the file, as these add invisible control characters that trip up the licensing and
make it hard for us to diagnose the fault.
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2. Copy the license key and paste it into the plain text file.
3. Save the file with a .lic extension (not .txt or .rtf) in the following directory: /Library/Application
Support/TheFoundry/RLM/
The name of the file can be anything, but we recommend calling it foundry.lic.
NOTE: There are other directories that can be searched for license files. See Moving the RLM
Files.
4. Create an options file and set a TIMEOUT or TIMEOUTALL period. This ensures that licenses are
returned to the server if the server and client machines lose contact with each other (due to a
network error, a crash, or some other failure). For more information, see Setting a TIMEOUT or
TIMEOUTALL Period.
5. Proceed to Installing Foundry Licensing Tools (FLT) on the License Server.

Installing Foundry Licensing Tools (FLT) on the License Server
1. Download FLT_7.3v1_mac-x86-release-64.dmg from our web site
(www.thefoundry.co.uk/support/licensing/) and install it on the Mac that you want to serve the
licenses across the network.
The license server starts automatically after installation (and whenever you restart the machine).
2. To check the server status, navigate to /Applications/TheFoundry/LicensingTools7.3, doubleclick on Foundry License Utility, view the RLM Server tab, and click Refresh Log.
To check RLM server status, you can also direct a web browser to the http://<server_
name>.local:4102 server page and click Status on the left.
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3. Proceed to Telling the Client Machines Where to Find the Licenses.

Telling the Client Machines Where to Find the Licenses
When you installed the floating license key on your server, you were provided with a <port>@<server
name>. You need this to license clients.
There are several ways to license clients. Choose one of the following and repeat it for each machine
you wish to have access to licenses on the server:
• If your product displays a Licensing dialog when you launch it, click Install License and then Use
Server. Type <number>@<server name> (for example, 4101@red) and click Install. Your client
retrieves a license from the License Server and launches.
• Navigate to /Applications/TheFoundry/LicensingTools7.3/ and double-click on
FoundryLicenseUtility to launch the FLU. Make sure you are viewing the License Install tab and
copy and paste in an RLM server line:
HOST <server name> any <port>
For example: HOST red any 4101
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This creates and installs a client license.
• Launch a Terminal and navigate to:
/Applications/TheFoundry/LicensingTools7.3/
Then, type the following commands:
cd FoundryLicenseUtility.app/Contents/MacOS/
./FoundryLicenseUtility -c <port>@<server name>
For example:
cd FoundryLicenseUtility.app/Contents/MacOS/
./FoundryLicenseUtility -c 4101@red
This creates and installs a client license.
• Set an environment variable on your client as follows:
Set the foundry_LICENSE environment variable on your client to point to the license server (for
example, 4101@red). If you have more than one server, you could use 4101@red:4101@green.
If you are using a port other than 4101, replace 4101 with the port selected.
For more information on setting environment variables, see Appendix B: FLT Variables.
• Although not recommended, you can manually create a client license.
• Copy the foundry.lic file from the server to:
/Library/Application Support/TheFoundry/RLM/
Rename the file and call it foundry_client.lic. Edit the file so it looks like this:
HOST red 000a957bade9 4101
or if you had your own server port number set:
HOST red 000a957bade9 30001

Linux
This section tells you how to get your floating license working on Linux.

Installing a Floating License on the License Server
1. Once a license has been generated for you, we e-mail you a .tgz file containing the license key and
instructions on how to obtain the correct version of the Foundry License Utility (FLU). On the
machine that acts as the license server, gunzip or untar the file and save the FLU and your license
key to a folder of your choice, for example /tmp. Note that the license file can be the original .lic
file or the license in a plain .txt file (as long as the file has a .lic extension).
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2. Navigate to the location of the FLU_7.3v1_linux-x86-release-64.tgz file.
3. Type the following commands to extract and install the FLU and the license. Note that you need to
replace [my license] with the location of your license key.
tar xvzf FLU_7.3v1_linux-x86-release-64.tgz
cd FLU_7.3v1_linux-x86-release-64
./FoundryLicenseUtility -l [my license]
For example, if you saved your license key to /tmp/Foundry.lic, the last line should be:
./FoundryLicenseUtility -l /tmp/Foundry.lic
This checks the license key and copies it to the correct directory.
4. The license server address is displayed on screen:
<number>@<license server name>
You should make a note of the address as you’ll need it to activate the client machines.
5. Proceed to Installing Foundry Licensing Tools (FLT) on the License Server.
NOTE: If there is an error with any part of the license installation, this is reported on the
command line. You should also see a Generate Report button, which you can click to write
the errors out to a file and then visit support.foundry.com for assistance.
If you are installing several licenses at the same time and only some of them fail validation,
you can continue to complete the installation of the valid licenses.
You may also get a message saying that the license is not yet valid but may be valid in the
future. This means the license has been installed successfully and will automatically become
live on the license start date. You do not need to do anything further, but if you like, you can
check that the server is up and the server log reports the same message (see Viewing the
License Server Log).
Alternatively, if you wish, you can install the license key by hand, though this is not recommended for
most users. To do so:
1. Launch a text editor and create a plain text file. Avoid using Word or other word processing
programs to create the file, as these add invisible control characters that trip up the licensing and
make it hard for us to diagnose the fault.
2. Copy the license key and paste it into the plain text file.
3. Save the file with a .lic extension (not .txt or .rtf) in the following directory:
/usr/local/foundry/RLM/
The name of the file can be anything, but we recommend calling it foundry.lic.
NOTE: There are other directories that can be searched for license files. See Moving the RLM
Files.
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4. Create an options file and set a TIMEOUT or TIMEOUTALL period. This ensures that licenses are
returned to the server if the server and client machines lose contact with each other (due to a
network error, a crash, or some other failure). For more information, see Setting a TIMEOUT or
TIMEOUTALL Period.
5. Proceed to Installing Foundry Licensing Tools (FLT) on the License Server.

Installing Foundry Licensing Tools (FLT) on the License Server
1. Download FLT_7.3v1_linux-x86-release-64.tgz from our web site
(www.thefoundry.co.uk/support/licensing/) on the Linux machine that you want to serve these
licenses across the network and save it to /tmp.
2. Open a shell and, using root or admin permissions, type these commands to extract and install
the Foundry Licensing Tools 7.3.
cd /tmp
tar xvzf FLT_7.3v1_linux-x86-release-64.tgz
cd FLT_7.3v1_linux-x86-release-64
./install.sh
The license server starts automatically after installation (and whenever you restart the machine).
3. To check the server status, navigate to /usr/local/foundry/LicensingTools7.3 and enter:
./FoundryLicenseUtility -s status
To check RLM server status, you can also direct a web browser to the http://<server_name>:4102
server page and click Status on the left.
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4. Proceed to Telling the Client Machines Where to find the Licenses below.

Telling the Client Machines Where to find the Licenses
When you installed the floating license key on your server, you were provided with a <port>@<server
name>. You need this to license clients.
There are several ways to license clients. Choose one of the following and repeat it for each machine
you wish to have access to licenses on the server:
• If your product displays a Licensing dialog when you launch it, click Install License and then Use
Server. Type <number>@<server name> (for example, 4101@red) into your Foundry product and
click Install. Your client retrieves a license from the License Server and launches.
• Launch a shell and navigate to:
/usr/local/foundry/LicensingTools7.3/
Then, type the following command:
./FoundryLicenseUtility -c <port>@<server name>
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For example:
./FoundryLicenseUtility -c 4101@red
This creates and installs both a client license.
• Set an environment variable on your client as follows:
Set the foundry_LICENSE environment variable on your client to point to the license server (for
example, 4101@red).
If you have more than one server, you could use 4101@red:4101@green.
If you are using a port other than 4101, replace 4101 with the port selected.
For more information on setting environment variables, see Appendix B: FLT Variables.
• Although not recommended, you can manually create a client license.
Copy the foundry.lic file from the server to:
/usr/local/foundry/RLM/
Rename the file and call it foundry_client.lic. Edit the file so it looks like this:
HOST red 000a957bade9 4101
or if you had your own server port number set:
HOST red 000a957bade9 30001

License Administration
The following section contains details on license management and administration, including file
location and updating licenses.

Where are the RLM Files?
You can move the RLM files anywhere, but by default they are installed to the following directories.
We refer to this directory throughout this guide and assume all the RLM components we ship are
here.

Application Files
These are files included in the Foundry License Installer. We’ll refer to this location as the <app path>.
<app path> on Windows:
C:\Program Files\The Foundry\LicensingTools7.3\bin\
<app path> on Mac OS X:
/Applications/TheFoundry/LicensingTools7.3/bin/
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<app path> on Linux:
/usr/local/foundry/LicensingTools7.3/bin/

Data Files
These include the license keys and log files. We’ll refer to these locations as the <data path>.
<data path> on Windows:
C:\ProgramData\The Foundry\RLM\
NOTE: The ProgramData folder may be hidden. You can make it visible using the Folder
Options in the Control Panel. See Windows Hidden Files.
<data path> on Mac OS X:
/Library/Application Support/TheFoundry/RLM/
<data path> on Linux:
/usr/local/foundry/RLM/

Moving the RLM Files
If you want to move a floating license key to another directory then, if you have a license server
already running, you need to shut it down. You’ll need to edit the startup scripts to look in the new
location. Then restart the license server.

On Windows
1. First, stop the license server if it’s running. Do one of the following:
• Navigate to Start > Control Panel > Systems and Security > Administrative Tools > Services.
Select Foundry License Server and click Stop.
• Use a web browser to go to the http://<server_name>:4102 server page. Click Status > Stop.
2. Click Start, type regedit, and then press Return on your keyboard.
3. Open the hierarchical structure HKEY_LOCAL_MACHINE > SYSTEM > CurrentControlSet > Services >
Foundry License Server:
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4. Move down the Registry as shown and select ImagePath.
5. Assuming your licenses are in C:\tmp, insert this into the path as shown:
"C:\Program Files\The Foundry\LicensingTools7.3\bin\rlm.foundry.exe" "-c"
"C:\ProgramData\The Foundry\RLM;C\tmp" "-ws" "4102" "-dlog"
"C:\ProgramData\The Foundry\RLM\log\foundry.log" -service
NOTE: Semi colons are used to separate license directories on Windows.
6. Quit regedit.
7. Restart the license server by doing one of the following:
• Navigate to Start > Control Panel > Systems and Security > Administrative Tools > Services.
Select Foundry License Server and click Start.
TIP: You can also stop and start the license server using the Foundry License Utility (FLU).
See Managing the License Server.

On Mac OS X
• Edit:
/Library/LaunchDaemons/uk.co.thefoundry.rlm.plist
changing these lines:
<string>-c</string>
<string>/Library/Application Support/TheFoundry/RLM/</string>
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to this, assuming your license is in /home/licenses:
string>-c</string>
<string>/Library/Application Support/TheFoundry/RLM/:/home/licenses</string>

On Linux
• Edit:
/etc/init.d/foundryrlmserver
changing this line:
FnLicDir=/usr/local/foundry/RLM
to this, assuming your license is in /home/licenses
FnLicDir=/usr/local/foundry/RLM:/home/licenses

When is a License Taken or Dropped?
Product licenses are checked out from the server when the product is first used on the client. Plug-in
products generally take a license when the first plug-in of the set is used.
When a license is returned to the server depends on a number of things. Let’s consider the following
scenarios:
• The Product Exits or is Deleted/Unloaded from the Client
• The Server and Client Machine Lose Contact with Each Other

The Product Exits or is Deleted/Unloaded from the Client
If the product exits or is deleted/unloaded from the client, the license is given back to the server.
Plug-in products generally return the license when the last plug-in of the set is removed from the
effects tree or layer stack. The exact point at which a license is returned by a plug-in product is hostspecific, and can be unpredictable.

The Server and Client Machine Lose Contact with Each Other
Should the server and client machines lose contact with each other (due to a network error, a crash,
or some other failure), licenses are returned to the server according to the TIMEOUT or TIMEOUTALL
flag set in the options file (foundry.opt):
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• If you installed an RLM license using the Foundry License Utility (FLU), the options file was created
automatically, with the TIMEOUTALL flag set to 3600 seconds (in other words, one hour). This means
the server waits for one hour before deciding that the client has crashed or failed in some other
way, then deems the license released, and makes it available on the network again. If you want to
change the default timeout period, you need to edit the options file. For instructions on how to do
this, see Setting a TIMEOUT or TIMEOUTALL Period.
• If you installed an RLM license manually, you must create the options file and set a TIMEOUTALL or
TIMEOUT period yourself. If you don’t, the server does not have a default timeout period and may
never release the license in some circumstances. For more instructions, see Setting a TIMEOUT or
TIMEOUTALL Period.

Setting a TIMEOUT or TIMEOUTALL Period
1. Create the options file if one doesn’t already exist. It should be a plain text file called foundry.opt
placed in the same directory as the license (unless a different options file location is specified in
the license file itself, either on the VENDOR or ISV line).
2. In the options file, you can set the TIMEOUT on a per-product basis, for example:
TIMEOUT mari_i 3600
TIMEOUT katana_r 600
The lines above tell the server that if it has not had communication with a mari_i client for an
hour, it should consider the license released. However, for the katana_r client, it should wait only
10 minutes before deciding the license is free to be served again.
You can also use:
TIMEOUTALL 3600
This tells the server that all features, except those with their own TIMEOUT flags, should time out
after one hour.
NOTE: For RLM licenses, the options file TIMEOUT can only be set to a minimum of 3600
seconds (1 hour), unless your license contains a min_timeout=<secs> flag.
3. Once you have edited your options file, you need to stop and start the license server:
• On Windows and Mac, launch the Foundry License Utility (FLU), go to one of the Server tabs and
click Stop Server, followed by Start Server.
• On Linux, launch a shell, navigate to where you saved the Foundry License Utility (FLU), and
enter the following command:
./FoundryLicenseUtility -s stop
Then, enter:
./FoundryLicenseUtility -s start
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TIP: You can also use the FLU from a Terminal on Mac OS X or a command prompt on
Windows.
TIP: To find out what the timeout period is set to, you can run the Foundry License Utility’s
Diagnostics tool (see Using the Diagnostics Tool in GUI Mode). This prints the contents of the
options file if one is found.

Capping Licenses
Have you ever needed a license only to find they have all been checked out by your colleagues? Just
needed a command to stop someone’s license so you can grab it? Then these are the commands for
you!
The rlmremove utilities allow you to remove a single user’s license for a specified feature. As ever,
let’s consider some examples.
First, who’s got the licenses?
• Using the rlmutil command:
<app path>/rlmutil rlmstat -c <data path> -a
NOTE: See Application Files and Data Files for the correct <app path> and <data path>.
The RLM command might produce this output:
foundry license usage status on licserv (port 38565)
mari_i v2015.1231: jack@red 1/0 at 10/07 14:40 (handle: 8a)
mari_i v2015.1231: mike@green 1/0 at 10/07 14:41 (handle: 67)
where the user is jack, the user’s computer is red, and the license handle is 8a.
To remove Jack’s license, use this command:
<app path>/rlmutil rlmremove licserv 38565 foundry 8a
Since it’s a bit rude to cap someone’s license, systems administrators can disable this functionality by:
• starting the rlm.foundry with a flag, -x rlmremove.

Appending to an Existing License
You can add a new license to an existing key using two methods:
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• On Windows and Mac OS X, drop the license file onto the Foundry License Utility. On Linux, run the
FLU from the command line using
./FoundryLicenseUtility -l [license path]. This is the recommended method.
• Edit the license file manually from the command line. This is not recommended for most users.

Manual Method
You can add a new license key by editing the foundry.lic text file and then using rlmutil to re-read
this file.
Here is an example floating license key for a machine called red with System ID 000EA641D7A1 that
serves 2 floating Mari licenses onto the network:
HOST red 000EA641D7A1 4101
ISV foundry
LICENSE foundry mari_i 2010.1231 permanent 2 share=h start=6-oct-2010
issued=6-oct-2010 _ck=fad7306732
sig="60Q04580SBD4AEEY4C93A1K0H718JRY9DWGP1HWR08AG1CY16HPHCKKQ44FDKGYQKE0BXKGR
J3WBT"
If you are then sent an Ocula license key for the same machine, just add the LICENSE lines to your
existing file, ignoring any HOST or ISV lines, so that it would look like this:
HOST red 000EA641D7A1 4101
ISV foundry
LICENSE foundry mari_i 2010.1231 permanent 2 share=h start=6-oct-2010
issued=6-oct-2010 _ck=fad7306732
sig="60Q04580SBD4AEEY4C93A1K0H718JRY9DWGP1HWR08AG1CY16HPHCKKQ44FDKGYQKE0BXKGR
J3WBT"
LICENSE foundry ocula_nuke_i 3.0 permanent 2 share=h start=6-oct-2010
issued=6-oct-2010 _ck=72d73079d7
sig="60PG4512DMXC338XEG3F0XBNPFREB6SHHD0QXA822M09MNJUB3E9VQUXKJP69DJ5CYR27AUY
FRS0"
Now re-read the license file with this command:
<app path>/rlmutil rlmreread -c <data path>
OR
Using a web browser, go to http://red:4102 and click Status > Reread.
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The <server_name> Variable
If you requested a floating license key but didn’t tell us the hostname of your license server, then we
will have given you a license key with <server_name> in the first line. You need to replace the text
<server_name> with the name of your license server (if you use the Foundry License Utility, it does
this for you).

Replace Licenses
You may see the word replace in your RLM license file. This flag is used in conjunction with the
issued flags to roll together multiple licenses.
For example, in the following RLM license for Mari, the replace flag forces RLM to ignore any mari_i
licenses with an issued date older than 1st December 2013.
HOST red 2c4138a7d9ba 4101
ISV foundry
LICENSE foundry mari_i 2013.1231 permanent 2 share=h min_timeout=30
start=1-dec-2013 issued=1-dec-2013 replace
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_ck=07d7a84d33
sig="60PG4580SR8RRKV7XM5E8J1XPV0BEV00PSASH0UV08A4MHS
EMWMKW520H34RNCGKM0XUVT229BT0"

Which RLM Port?
Although the default port used by RLM is 5053, Foundry has opted to use port 4101 for all its licenses
to ensure there are no conflicts with any other RLM license servers that may be running on the server.
If, however, no port is specified on the HOST line of a license, or in the foundry_LICENSE
environment variable, the port defaults to 5053. For example, the following entry:
HOST red 000EA641D7A1
behaves in the same way as:
HOST red 000EA641D7A1 5053
Licenses sent to you by Foundry appear as follows:
HOST red 000EA641D7A1 4101
If you wish to change this port number, ensure that you modify all your client licenses in the same
way.

Managing the License Server
Starting the License Server
The License Server starts automatically when you reboot your machine, but you can start it manually:
• On Windows and Mac OS X, launch the Foundry License Utility (FLU), go to the RLM Server tab, and
click Start Server.
TIP: You can also use the FLU from a command prompt on Windows or a Terminal on Mac
OS X.
• On Linux, launch a shell, navigate to where you saved the Foundry License Utility (FLU), and enter
one of the following commands:
./FoundryLicenseUtility -s start
• On all platforms, if your product uses RLM licensing, you can also use a web browser to navigate to
the http://<server_name>:4102 server page. For example, http://red:4102. Click the Status button,
and click Start on the Foundry License Server.
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NOTE: On Mac OS X, if you’re browsing from the License Server itself, you must add .local in
the browser address: http://<server_name>.local:4102.

Stopping the License Server
To stop the license server:
• On Windows and Mac OS X, launch the Foundry License Utility (FLU), go to the RLM Server tab, and
click Stop Server.
TIP: You can also use the FLU from a command prompt on Windows or a Terminal on Mac
OS X.
• On Linux, launch a shell, navigate to where you saved the Foundry License Utility (FLU), and enter
one of the following commands:
./FoundryLicenseUtility -s stop
• On all platforms, if your product uses RLM licensing, you can also use a web browser to navigate to
the http://<server_name>:4102 server page and click Stop.
NOTE: On Mac OS X, if you’re browsing from the License Server itself, you must add .local in
the browser address: http://<server_name>.local:4102.

Viewing the License Server Log
You can view the license server log even if you don’t have administrator privileges. To do so:
• On Windows and Mac OS X, launch the Foundry License Utility (FLU), go to the RLM Server tab, and
click Refresh Log.
TIP: You can also use the FLU from a command prompt on Windows or a Terminal on Mac
OS X.
• On Linux, launch a shell, navigate to where you saved the Foundry License Utility (FLU), and enter:
./FoundryLicenseUtility -s status
• On all platforms, you can also use a web browser to navigate to the http://<server_name>:4102
server page and click the Status button.
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NOTE: On Mac OS X, if you’re browsing from the License Server itself, you must add .local in
the browser address: http://<server_name>.local:4102.

RLM Web Server
The RLM web server also allows you to:
• retrieve server and license status (similar to rlmstat)
• cause the servers to re-read the license files (rlmreread)
• switch debug (rlmswitch) or report log (rlmswitchr) files
• move the current report log file to a new name (rlmnewlog)
• shutdown and startup the license servers (rlmdown/rlmreread).
Using this web-based interface, you can administer the license server from any platform, and you do
not need to install the RLM utilities - you only need a web browser.
• Main Status - if you select Status from the menu on the left, the main status screen is displayed in
the view area as shown below.
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• Server Status - click on an ISV button in the Server Status column to display a detailed status
display for an individual ISV server in the view area. This displays some server statistics in a table at
the top, followed by a table of all the licenses served by this ISV server.
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• License Status - if you click on the usage... button in the Show License Usage column above, you
see the license status screen, as shown.

• Reread/Restart/Shutdown - click Reread/Restart Servers from the menu on the left (or from the
REREAD column in the ISV server status display) to display the Reread/Restart Servers screen in
the view area. Enter an ISV name and click REREAD/RESTART. This restarts the server if it is not
running, or sends it a reread command if it is running.
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You can also type all to refresh or restart all discovered servers.

Useful Commands for System Administrators
Type all these commands from the the Foundry RLM applications directory on the server.
See Application Files for a description of the <app path> variable, and Data Files for a description of
<data path>.

Is the License Server Up and Running?
<app path>/rlmutil rlmstat -c <data path>

I’m Using Foundry Software on Machine "blue". Which Licenses is the License Server "red"
Offering?
<app path>/rlmutil rlmstat -c <port>@red -a

What is My System ID Number?
<app path>/rlmutil rlmhostid
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What’s My <server_name>?
<app path>/rlmutil rlmhostid host

Show Me All My Licenses and Who has Checked Them Out.
<app path>/rlmutil rlmstat -c <data path> -a
OR
Use a web browser to go to http://<server name>:4102 and click Status > Server Status to view
license usage.
NOTE: On Mac OS X, if you’re browsing from the License Server itself, you must add .local in
the browser address: http://<server_name>.local:4102.

Who Has Checked Out a Particular License?
<app path>/rlmutil rlmstat -c <data path> -p mari_r

I’ve been given a new floating license key, which I’ve edited into my license file, but it has not been
picked up by the server. What do I do?
• On Windows and Mac OS X, launch the Foundry License Utility, go to one of the Server tabs, and
use the Reread Server button.
• Alternatively, use one of the following:
<app path>/rlmutil rlmreread -c <data path>
• You can also use a web browser to go to http://<server name>:4102 and click Reread/Restart
Servers. Enter the server name you want to reread and click Reread/Restart.
NOTE: On Mac OS X, If you’re browsing from the License Server itself, you must add .local in
the browser address: http://<server_name>.local:4102.

My Default Debug Log File (foundry.log) is Too Big. How do I Start a New One Called october.log
Without Interrupting the rlm.foundry Daemon?
<app path>/rlmutil rlmswitch foundry october.log
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Removing FLT
On Windows
To stop the Foundry License Server and remove FLT from your machine, from the Start menu go to
All Programs > The Foundry > FLT 7.3v1 > Uninstall FLT 7.3v1.

On Mac OS X
To stop the Foundry License Server and remove FLT from your machine, run the FLT Uninstaller
script from a terminal with root or sudo permissions:
/Applications/TheFoundry/LicensingTools7.3/uninstall.sh

On Linux
To stop the Foundry License Server and remove FLT from your machine, run the script:
/usr/local/foundry/LicensingTools7.3/uninstall.sh
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There are many reasons why your license key may fail to work. This section is here to guide you
through some common problems and how to fix them.

NOTE: The Foundry Licensing Tools’ default settings do not support RLM licensing on virtual
machines (VMs). If you have any questions regarding licensing on VMs, please visit
support.foundry.com for assistance.

Firewalls
The Problem
You have set up a floating license, but client machines are not able to get a license from the server.
Everything seems to be set up correctly. The server is running and is floating licenses. The client is
correctly pointing to the server using a client.lic file or an environment variable. So what’s wrong?

The Solution
This could be any number of things, but if everything is set up correctly, it could be the firewall on the
server blocking perfectly legitimate requests from the client. In order to fix this, you need to specify
ports for your servers and allow these to be open.
• If you’re on Windows, see Windows.
• If you’re on Mac OS X, see Mac OS X.
• If you’re on Linux, consult your system administrator.

Windows
Two firewall exception methods are available to enable client machines to checkout licenses and
connect to the web service in the License Server: programs and port numbers.
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Windows Program Exceptions
1. From the Windows Start menu, click Control Panel > System and Security > Windows Firewall
and then click on the Advanced settings link.

2. Select Inbound Rules in the left-hand panel and click New Rule as shown below.

3. Select Program and then click Next.
4. Select This program path and then browse to the following location:
C:\Program Files\The Foundry\LicensingTools7.3\bin\RLM
Add rlm.foundry.exe.
5. Click Allow the connection and then click Next.
6. Select all the checkboxes that apply to the rule. Domain, Private, and Public in the example
below.
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7. Click Next and enter a meaningful name for the rule, such as RLM_HOST.
8. Click Finish to complete the process.
9. Stop and Start the license server as described in Managing the License Server.

Windows Port Exceptions
You need to change your license file to include two different port numbers. RLM requires an options
file entry.
If you installed an RLM license using the FLU, the options file was created automatically in the same
directory as your license. If, however, you installed your license manually, create a plain text file called
foundry.opt in the same directory as the license. See Where are the RLM Files? for the license file
location.
A typical RLM licence including port numbers and an options file might look like this:
HOST red 000ea641d7a1 4101
ISV foundry OPTIONS=foundry.opt PORT=12345
NOTE: You may want to check with your system administrator that the port number you
choose is not already in use by another program.
A foundry.opt file for Mari should contain the following line:
TIMEOUT mari_i 3600
Or, for all RLM licensed products:
TIMEOUTALL 3600
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After editing the license and options file, stop and start the license server as described in Managing
the License Server. In the license server interface, click Status and check that the ports specified are
listed and that the server is running.

Next, go to your firewall settings and add Inbound Rules for TCP ports with the port numbers in the
HOST and ISV lines.
1. From the Windows Start menu, click Control Panel > System and Security > Windows Firewall
and then click on the Advanced settings link.
2. Select Inbound Rules in the left-hand panel and click New Rule as shown below.

3. Select the Port radio button and then click Next.
4. Select TCP and Specific local ports and enter the port number in the field provided (4101 in the
example).
5. Click Next.
6. Select Allow the connection and click Next.
7. Select when the new rule should be applied using the checkboxes. In the example, the rule is
applied at all times, but you can modify this as required.

67

| Windows Port Exceptions

8. Click Next.
9. Enter a meaningful name for the new rule, for example RLM_HOST, and write a description, if
required.
10. Click Finish.
11. Select the new rule from the Inbound Rules list and click Properties.
12. Click the Programs and Services tab, select This program, and browse to <app
path>/rlm.foundry.exe as shown.

13. Click Open to return to the Properties dialog.
14. Click Apply, and close the dialog.
15. Repeat the process for the ISV port, replacing the port number and rule name.
16. Click the Programs and Services tab, select All programs that meet the specified conditions.
17. Click OK to close the dialog.
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Mac OS X
You need to adjust your firewall settings. How to do this depends on your firewall and the version of
Mac OS X you are running, but here’s how to do it on Mac OS X 10.6 (Snow Leopard):
1. Launch System Preferences.
2. Click on Security & Privacy and go to the Firewall tab.
3. Click the Firewall Options button.
NOTE: You may need to click the lock icon at the bottom-left to enable changes.

4. Under the list of incoming connections, click on the + button.
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• Navigate to /Applications/TheFoundry/LicensingTools7.3/bin/RLM
• Select rlm.foundry and click Add.

Windows Hidden Files
On Windows, the C:\ProgramData directory may be hidden. You can make it visible by navigating to
Control Panel > Appearance and Personalization > Folder Options > View tab and then selecting
Show hidden files, folders, and drives.
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Enable Show hidden files, folders,
and drives.

Node Locked and Client Licenses
If you have a node locked license in a client license file that is pointing to the server for its licenses,
the node locked license won’t work. Use separate files for the node locked license (foundry.lic) and
client license (foundry_client.lic). For example, this Mari RLM license won’t work in this file that is
looking on “red” for its licenses.
HOST red 000EA641D7A1 4101
ISV foundry
LICENSE foundry mari_i 2011.1006 permanent uncounted hostid=000ea641d7a1
share=h start=6-oct-2010 issued=6-oct-2010 _ck=fbf430af8c
sig="60PG4515BFTJCYAXSYJ6GTUJ3B9NRRGF3VUUKD022M0BXU48SSESUGSAFJ8BAD5BN883526E
TKQ0"
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Accessing the RLM Web Server on Mac OS X
The Problem
On Mac OS X, you’re browsing to http://<server_name>:4102, on the License Server itself, looking for
the RLM Web Server page, but you can’t connect.

The Solution
Due to Mac OS X system architecture, you must add .local to the URL address when you’re browsing
from the License Server itself:
http://<server_name>.local:4102
NOTE: You can use this address on other platforms, but it’s not necessary.

Contacting Support
If you have flicked through this guide and haven’t found the answer to your question, then please:
1. See the frequently asked questions at support.foundry.com/hc/en-us/categories/200904012License-Help.
2. Run the Foundry License Utility’s diagnostics tool in GUI mode (Windows and Mac) or from the
command line (Windows, Mac, and Linux). This gives you a text file that you can send to support
for assistance. See Using the Diagnostics Tool in GUI Mode or Using the Diagnostics Tool in
Command Line Mode.
3. Visit support.foundry.com for assistance.

Using the Diagnostics Tool in GUI Mode
1. Launch the Foundry License Utility (FLU).
2. Go to the Diagnostics tab, and click Run Diagnostics.
This gathers lots of information on your machine that helps us diagnose the problem. No
personal information is gathered.
3. Click Save to write out a text file we can use to assist you when you visit support.foundry.com.

Using the Diagnostics Tool in Command Line Mode
1. Launch a command prompt (Windows), a Terminal (Mac), or a shell (Linux).
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2. Navigate to the directory where you have saved the Foundry License Utility (FLU).
3. Enter one of the following commands.
Windows
FLU_7.3v1_win-x86-release-64.exe -d
Mac OS X
./FoundryLicenseUtility.app/Contents/MacOS/FoundryLicenseUtility -d
Linux
./FoundryLicenseUtility -d
This gathers lots of information on your machine that helps us diagnose the problem. No
personal information is gathered.
4. The tool prompts you to save a text file we can use to assist you when you visit
support.foundry.com. To do so, enter Y.
TIP: By default, the file is saved to your home directory and given an automated file name. If
you’d like to specify a different directory and name, use -f <path> instead. For example, on
Windows:
FLU_7.3v1_win-x86-release-64.exe -f C:\temp\log.txt
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This section describes the various syntax requirements for the Foundry Licensing Tools (FLT).

Node Locked License Syntax
A node locked or uncounted RLM license looks like this:

LICENSE foundry katana_i 2012.1006 permanent uncounted hostid=000ea641d7a1
share=h start=6-oct-2012 issued=6-oct-2012 _ck=fbf430af8c
sig="60PG4515BFTJCYAXSYJ6GTUJ3B9NRRGF3VUUKD022M0BXU48SSESUGSAFJ8BAD5BN883526E
TKQ0"
Node locked RLM licenses are broken down into 11 parts:
• LICENSE - indicates the start of an RLM license feature.
• foundry - the vendor name. All licenses from the Foundry must contain the vendor name foundry.
• katana_i - the product to be licensed. In this example, it’s a Katana interactive license. A background
render license would be katana_r.
• 2012.1006 - the maintenance date. All Katana releases built before this date will run until the license
timeout. All releases built after this date will not run.
• For non-maintenance products, this is often just the version of the product, for example 3.0.
• permanent - this is a permanent license. If this field were a date 5-jul-2012, it would be a temporary
license with that expiry date.
• uncounted - this is a node locked license. Floating licenses have a number in place of the
uncounted tag.
• hostid - also known as the System ID, this is the ethernet (mac) address of the machine to be
licensed.
• share - this indicates how multiple checkouts from the same client machine are treated. share=h
indicates licenses are shared by the same host.
• start=6-oct-2012 - the date when the license starts. This date may be in the future.
• issued - the day the license was made, which may differ from the license start date.
• ck and sig - the encrypted license key. It represents a unique hash of the information in the license
and is used to validate the license.

Floating License Syntax
A floating or counted RLM license looks like this:
HOST <server_name> <server host id> <port>
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ISV foundry <options file> <port>
LICENSE foundry mari_i 2012.1006 permanent 10 share=h start=6-oct-2012
issued=6-oct-2012 _ck=fb063057fd
sig="60PG451E0VM5S81E5EWRYM8E82CMKYR6SSB93P822M0AT1UU7FWA85M9P34UKXK4HMD7ERG6
5YA0"
Floating licenses are broken down into a HOST line, an ISV line, and one or more LICENSE lines:
HOST - The host line indicates which server may provide the floating licenses in the license file.
• <server_name>, also known as the hostname, is the name of the license server, for example red.
• <server host id>, also known as the rlmhostid or System ID, is a unique number for that machine.
• <port> is the user-defined server port number over which requests from the client are made to the
RLM daemon.
ISV - The ISV line indicates which vendor made the license. The vendor line helps decode the license
line for the Foundry's specific licensing keys and identify the vendor licensing daemon.
• <options file> is the plain text file that controls the behavior of the server. Specifying an options file
in the license is optional.
• <port> is the user-defined port over which the vendor daemon communicates to the client. If left
blank, the port number is picked for you.
NOTE: The host port number and the ISV port number MUST be different, and remember to
avoid port 4102, which is reserved for the web server.
LICENSE - license feature line. The only difference from a node locked license is that uncounted is
replaced with the number of available floating licenses and the hostid in omitted from the LICENSE
block.
The above license works on any 10 hosts simultaneously. It licenses all Mari releases built before 6
October 2012 and it begins 6 October 2012.

Client License Syntax
Client RLM licenses typically have just one line, which may be:
HOST <server name> <server host id> <port number>
or
HOST <server name> any <port number>
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Appendix B: FLT Variables
This section describes the environment variables that the Foundry Licensing Tools (FLT) recognize.

Environment Variables FLT Recognizes
There are many occasions when you might need to set an environment variable to tailor the
functionality of FLT. The following table lists the environment variables FLT recognizes.
Environment
Variable

Description

foundry_LICENSE

Sets the location of the license file.
If you move your license file, you can set this to point to the new location.
You can also use this to point client machines to a floating license on a license
server machine.

foundry_LICENSE_
LOG

Sets the location of the log file that gets generated if there are problems with
licenses.

Setting Environment Variables
Of course, how you set environment variables differs for each operating system. Here’s a brief guide if
you can’t find your systems administrator.

Windows
1. Go to Start > Control Panel > System and Security > System.
2. Click Advanced system settings in the left-hand panel and then the EnvironmentVariables
button. You can specify system-wide variables that all users will pick up or user variables to
restrict the environment variable to one particular user.
3. Click on New and enter the variable name and value.
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Mac OS X
You can easily set an environment variable that is active in one terminal only:
1. The procedure for setting an environment variable depends on what your default shell is. To get
the name of the shell you are using, launch a terminal (Applications > Utilities > Terminal) and
enter:
echo $SHELL.
2. Depending on the output of the previous step, do one of the following:
• If your shell is a csh or tcsh shell, enter:
setenv foundry_LICENSE /tmp/foundry.lic
• If your shell is a bash or ksh shell, enter:
export foundry_LICENSE=/tmp/foundry.lic
You then need to run the product from the same terminal that you used to set the environment
variable. If you open another terminal, this environment variable is not set in that terminal unless you
type it in there too.
For a more permanent solution, you can set an environment variable for all processes launched by a
specific user by creating an environment file in the user’s home directory:
~/.MacOSX/environment.plist
NOTE: The tilde ( ~ ) represents the home directory of the target user, and the command is
case sensitive, so take care to copy the string exactly.
You have to create the .MacOSX directory yourself using a terminal (by typing mkdir .MacOSX in
your home directory). You also have to create the environment file yourself. The environment file is
actually in XML/plist format (make sure to add the .plist extension to the end of the filename or this
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won't work). An example environment file is shown below. The file can be created using
/Developer/Applications/Utilities/PropertyListEditor.app or you can use a text editor if you’re
careful with the formatting. We can also send you one if you wish.
<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE plist PUBLIC "-//Apple Computer//DTD PLIST 1.0//EN"
"http://www.apple.com/DTDs/PropertyList-1.0.dtd">
<plist version="1.0">
<dict>
<key>foundry_LICENSE</key>
<string>/tmp/foundry.lic</string>
</dict>
</plist>
In this case we set the environment variable foundry_LICENSE to /tmp/foundry.lic. Note also that the
environment variable is only active once you’ve logged out and logged back in.

Linux
1. The procedure for setting an environment variable depends on what your default shell is. To get
the name of the shell you are using, launch a shell and enter:
echo $SHELL.
2. Depending on the output of the previous step, do one of the following:
• If your shell is a csh or tcsh shell, enter:
setenv foundry_LICENSE /tmp/foundry.lic
• If your shell is a bash or ksh shell, enter:
export foundry_LICENSE=/tmp/foundry.lic
3. You then need to run the product from the same terminal that you used to set the environment
variable. If you open another terminal, this environment variable is not set in that terminal unless
you type it in there too.
4. To make this permanent for any shell launched, you can edit your .cshrc, .tcshrc, .bashrc, or
.kshrc file in your home directory.
5. If you want it to be system wide, then /etc/profile can be used (or /etc/environment on some
flavors of Linux).
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